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Product Overview
Microsoft Outlook is the most widely used e-mail and corporate calendaring system for mid-
sized companies worldwide.  SalesLogix has created an unprecedented level of integration
between the two applications so that the end-user can seamlessly use both Outlook and
SalesLogix.  The main areas of focus for the integration are in E-mail, Calendar, Contacts and
Synchronization.

Feature Overview

Standard Outlook Integration Features

Add SalesLogix Contacts to Outlook
One-click Send SLX in Outlook e-mail
Save Outlook attachments to SalesLogix
One-click Record to SalesLogix History from Outlook Inbox
Drag and drop from Outlook Inbox to SalesLogix History
Use SalesLogix Address Book in Outlook e-mail
Attach documents from SalesLogix Library in Outlook e-mail
Attach SalesLogix Contact vCard in Outlook e-mail

Advanced Outlook Integration Features

Flag Outlook e-mail received from SalesLogix Contacts
Outlook Attendee availability in SalesLogix
Meeting Requests Scheduled in SalesLogix and Outlook (even for non-SalesLogix users)
Use Outlook Calendar in SalesLogix (user option)

SalesLogix Intellisync Synchronization Features

Full Outlook synchronization without user intervention
Synchronize to PDA
Add Outlook Contacts to SalesLogix

SalesLogix Exchange Link Features

Server-side SalesLogix to Exchange Server integration
 Link SalesLogix and Exchange Server Contacts
 Link SalesLogix and Exchange Server Calendar Activities
 Link SalesLogix To Dos with Exchange Server Tasks
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Which Outlook Integration features are right for you?
The following chart shows which Outlook Integration features will work for which types of
SalesLogix users.

SalesLogix Exchange Link does not require Microsoft Outlook Windows client to be installed.
All other configurations assume that Microsoft Outlook Windows client is installed on the local
machine.

SalesLogix Implementation
Scenarios

Intellisync
for

SalesLogix

SalesLogix
Exchange

Link

Standard
Outlook

Integration

Advanced
Outlook

Integration

All SalesLogix Windows Client
Users, no Remote Users  (1)  (1)

All SalesLogix Windows Client
Users, with Remote Users  (2)  (2)

All SalesLogix Web Client Users (3)

SalesLogix Support Client(4)

SalesLogix Windows Client Users
using Terminal Server or Citrix (5) (5) (5)

(1) Intellisync or SalesLogix Exchange Link may be used.  It is not recommended that both
be used in the same environment.  See the Comparing Intellisync and SalesLogix
Exchange Link section to determine which is preferred in your environment.

(2) Intellisync or SalesLogix Exchange Link may be used.  It is strongly recommended that
Remote Users use the Intellisync option.  With Intellisync changes are updated when
Outlook synchronizes with Exchange; with Exchange Link changes must sync to
SalesLogix and then sync to Exchange so items may appear temporarily outdated if
changed during the sync process.  See the Comparing Intellisync and SalesLogix
Exchange Link section to determine which is preferred in your environment.

(3) Limited Standard Outlook Integration features are optionally available on the Web Client
with Outlook Client installed (requires ActiveX download).  See the Standard Outlook
Features section for details.

(4) SalesLogix Support Client has limited e-mail integration detailed in the Support Client
help.

(5) Intellisync, Standard, and Advanced Outlook Integration features may be installed and
used if the Microsoft Outlook Windows client is installed and used in the same
Citrix/Terminal Server environment.  If you choose this environment, there are additional
considerations detailed below.

Intellisync
for

SalesLogix

SalesLogix
Exchange

Link

Standard
Outlook

Integration

Advanced
Outlook

Integration

Running both Outlook & SLX on Citrix/Terminal Server Yes Yes Yes Yes

Running both Outlook & SLX on the Citrix/Terminal
Server AND on the local machine

No Yes Yes Yes
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If SalesLogix/Outlook are running on Citrix/Terminal Server in a multiple server environment, “Roaming Profiles” must be
enabled so that “Current User” registry settings, \Documents and Settings\User, and \Program Files\SalesLogix\Intellisync
folders are synchronized on every machine.

If you run SalesLogix and Outlook on both the Citrix/Terminal Server and on your local machine, you cannot use
Intellisync because the “Intellisync log” is stored on a single machine.  If you are set up in this way, it is recommended that
you configure Outlook Sync to run only manually and disable the other “Sync Run Time” options.

The Citrix/Terminal Server directory must be set in your machine’s local registry and the slmn.dll file must be installed and
registered.  You can send e-mail with the Send SLX button and the history record will be created the next time you log on
to the Sales Client on the Citrix/Terminal Server. While this operation will happen automatically, you must first have
permissions and the ability to cut and paste files in Windows Explorer from your local machine to the Citrix Server. (This
also assumes that argument #2 has been met).

Viewing contacts directly from the SalesLogix Database using the SalesLogix Address Book in Outlook is available only
when you are logged on to the Citrix/Terminal Server and using Outlook from the Citrix/Terminal Server.  However, while
using SalesLogix on the Citrix/Terminal Server, you can use the “Add Contact(s) to Outlook” function and store your more
frequently used contacts from SalesLogix in Outlook to be used as an offline Address Book.  (This also assumes that
argument #2 has been met).

Outlook Sync can run only when you are connected to the Citrix/Terminal Server machine.  In this case, it is
recommended that you synchronize Contact and Calendar items manually as opposed to the utilizing the automatic
option.  (This also assumes that argument #2 has been met).
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Standard Outlook Integration Features
In most cases, these features only operate with the Microsoft Outlook Windows client.  You
must have Microsoft Outlook Windows client installed and configured for these features, even
when using the SalesLogix Web Client.  The Outlook Web Access client (OWA) is a thin client
that lacks the client-side logic to operate these features.

Add SalesLogix Contact to Outlook
Choose Outlook > Add Contact(s) to Outlook from the menu bar, toolbar icon, or right-mouse
click to move a contact (or multiple contacts) from SalesLogix into Outlook.  The SalesLogix
contact information is captured and an Outlook Contact form is pre-populated and opened.  The
user simply clicks “Save and Close” and the Contact is added to the standard Outlook Contacts
folder.

One-Click Send SLX in Outlook E-mail
The “Send SLX” button in Outlook e-
mail allows you to send an e-mail and
have the e-mail recorded to SalesLogix
History with one click.

Save Attachments
When using the Send SLX button to
send an e-mail containing attachments,
the user is prompted to add the
attachment(s) to the SalesLogix
Attachments tab.
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One-Click Record to SalesLogix History From Outlook
A button on the Outlook toolbar will record e-mail to SalesLogix History with one click.  This
button has the same functions as the “Send SLX” button for prompting to record attachments
associated with an e-mail.  This feature is helpful for recording e-mail messages to history
directly from the Inbox (or other folders) without responding to the message.

Drag and Drop from Outlook to SalesLogix History
Record e-mails to SalesLogix History by simply dragging and dropping from Outlook onto
SalesLogix.  The user will be prompted to add details about the e-mail and may simply click OK
to record the e-mail to SalesLogix.

Use SalesLogix Address Book in Outlook E-mail
Select contacts directly from SalesLogix as recipients of Outlook e-mail.  Click on the TO or CC
button of an e-mail, select to the SalesLogix Address Book, and choose from the list of
SalesLogix Contacts.

When typing pieces of a
contact name, contacts in
SalesLogix can also be
automatically “recognized”
by Outlook.  When they
are recognized, a “(SLX)”
will be placed after the
underlined name.
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Attach Documents from SalesLogix Library in Outlook
Select documents directly from SalesLogix Library to attach to Outlook e-mail.  It only takes two
steps to insert a file from the SalesLogix Library into an e-mail.  With this feature, use the
SalesLogix Library as a tool for electronic literature fulfillment.
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Advanced Outlook Integration Features
Advanced Outlook Integration adds additional integration
features if Outlook and Exchange Server are used as the
corporate messaging system.  Exchange Server is required for
these Advanced Outlook Integration features.

An Administrator must enable Advanced Outlook Integration for
all users.  The option is found in SalesLogix Administrator under
the Tools > Options menu on the Outlook tab as shown here.

These features only operate with the Microsoft Outlook
Windows client.  You must have Microsoft Outlook Windows
client installed and configured for these features.  The Outlook
Web Access client (OWA) is a thin client that lacks the client-
side logic to operate these features.

Flag Outlook E-mail Received from SalesLogix Contacts
Let SalesLogix assist you with e-mail priority management by checking unread e-mail messages
against the SalesLogix database and “flagging” e-mail from customers and prospects.

SalesLogix can help
identify which e-mails to
respond to first!
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Outlook Attendee Availability in SalesLogix
When you schedule a Meeting or Phone
Call in SalesLogix, the “Members” and
“Resources” tabs are replaced with an
“Attendee availability” tab.

This tab replicates the information found when
scheduling a meeting in Outlook and is used by
SalesLogix users to schedule appointments for
SalesLogix and non-SalesLogix users alike.

Meeting Requests
When you click “OK” to complete the meeting,
you are prompted to send an invitation to the
other users you have selected.  From this point
on, activities scheduled in SalesLogix are
“carried” using Outlook Meeting Request e-
mails and the “Accept/Decline” process is
handled by Outlook.

Once the meeting is created in SalesLogix and
sent out as an Outlook Meeting request, it is
then replicated as an Appointment in Outlook.

Use the Outlook Calendar in SalesLogix (User Option)
If users prefer to use the Outlook
Calendar to the SalesLogix
Calendar, each user may change
their Calendar Options to open
Outlook by default when the
SalesLogix Calendar icon is clicked.
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Intellisync Synchonization Features
Intellisync is a client-side synchronization of SalesLogix with Microsoft Outlook.  Intellisync is
fully compatible with Standard and Advanced Outlook Integration features.

These features only operate with the Microsoft Outlook Windows client.  The Outlook Web
Access client (OWA) is a thin client that lacks the client-side logic to operate these features.

Automatic Outlook Synchronization
Synchronization now can be set up to run automatically and silently so users never have to click
a button or run a program.

From the SalesLogix Windows Client, choose Tools > Options to access Outlook
Synchronization options.  The SalesLogix Administrator may disable these options for any
users.

The user can set up the current
Contact Sync Group.

Note that after the group has
been set up the first time, it
cannot be changed from this
view. Choosing this option

enables running
Outlook Sync “silently”
and unobtrusively.

By setting Outlook Sync to run
automatically, the SalesLogix calendar
and Outlook calendars will never be out
of sync.

From this view, the user can
configure which sections of
SalesLogix to synchronize with
Outlook.

When Outlook is
synchonizing, the Blue
and Green Arrows in
the SalesLogix Status
Bar are animated.

If you prefer to synchronize
Outlook manually, choose the
Outlook menu in SalesLogix
to “sync now”.
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Synchronize to PDA
Now that SalesLogix and Outlook are automatically synchronizing, users can sync those
contacts, calendar items, and tasks from Outlook to your PDA of choice.

The following diagram demonstrates the data exchange process among SalesLogix, Outlook
and your PDA device.

Outlook Meeting Requests for SalesLogix Users
As previously discussed, SalesLogix users’ calendars are replicated and synchronized with your
Outlook Calendar.  This means that all non-SalesLogix users can now view SalesLogix
availability when scheduling meetings in Outlook.

Rivers (a non-SalesLogix user) sees
that you are free from 1 – 2 PM and
schedules an appointment for you,
Lee Hogan (a SalesLogix user), and
several others…

…You receive a
meeting request in
your Inbox from
Rivers…

… You open the e-mail and
decide whether to accept,
decline, or mark the
appointment as tentative.

If you Accept, this appointment
is added to your Outlook
calendar and automatically
synchronized to your SalesLogix
calendar.

Keep your business contacts in SalesLogix, your
personal and business contacts in Outlook, and then
sync it to your PDA of choice for offline access to your
Address Book and Calendar!!
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Add Outlook Contacts to SalesLogix
If the user has already been set up to synchronize Contacts with Outlook and the appropriate
Contact Sync Group has been created (usually called SyncSalesLogix), the user may add the
“SyncSalesLogix” pick list option in the Category field and let synchronization run to add existing
Outlook Contacts into SalesLogix.

Please read the FAQ’s to learn how to prevent duplicates in SalesLogix.

Adding “SyncSalesLogix” to the
Category field in the Outlook Contact
allows SalesLogix to filter through the
personal contacts in Outlook and
synchronize only the business
contacts from SalesLogix.
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SalesLogix Exchange Link Features
SalesLogix Exchange Link is server-side linking and synchronization of contacts and calendars
between SalesLogix and Microsoft Exchange Server.  SalesLogix Exchange Link uses a
concept of multiple links, each link shares a set of SalesLogix Contacts or calendar Activities in
SalesLogix (defined using a simple interface to pick users and/or teams) to a folder in Exchange
(either a mailbox or Public folder).  This gives flexibility on Contacts and Activities that are linked
to minimize the processing and load on both the SalesLogix Server and the Exchange Server.
To the user, this process is seamless and invisible.

SalesLogix Exchange Link does not require Outlook or Intellisync to operate.  SalesLogix
Exchange Link is fully compatible with Standard and Advanced Outlook Integration features.

Installation and Configuration
 Runs as a Windows service on existing SalesLogix Server with minimal processing

impact

 Links and changes are logged for complete system monitoring

 Configure time interval for links to synchronize

Contact Linking
 Link SalesLogix and Exchange Server Contacts

 Define link rules by user or team or for all Contacts

 Check and resolve conflicts and duplicates with configurable rules

Activities Linking
 Link SalesLogix and Exchange Server calendar activities

 Define link rules on a user-by-user basis

 Check and resolve conflicts and duplicates with configurable rules
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Comparing Intellisync and SalesLogix Exchange Link

Feature/Function Intellisync for SalesLogix SalesLogix Exchange
Link

Installation and configuration Every User Server-side

Requires Outlook Windows client Yes No

Requires Exchange Server No Yes

Supports One-way synchronization Yes No

Supports SalesLogix Web Client No Yes

Supports SalesLogix Events Yes No

Possible compatibility issues with different
versions of Intellisync provided by device
manufacturers

Yes No

Limited support for Lotus Notes and
Novell Groupwise Yes No

Requires Administrative rights to the
Exchange Server No Yes

Users can modify sync rules Yes No

Can link PDAs directly to SalesLogix
rather than through Exchange Server or
Outlook (not usually recommended)

Yes No

Frequently Asked Questions (FAQs)
Q: Is there an additional charge for the Outlook Integration features?
A: No, in most cases. Only Exchange Link is an additional cost with some versions of
SalesLogix.
Q: What versions of Outlook will be supported?
A: See the Compatibility Checklist on SupportOnline for most current compatibility information.
Q: What is the slmn.dll file in the SalesLogix folder?
A: The slmn.dll stands for “SalesLogix Mail Notification”. It contains the functionality for the Send
SLX and SLX Icon buttons - basically recording e-mail to history. It can be turned on and off in
the Outlook “Add-in Manager” under the same name “SalesLogix Mail Notification”.

Q: What is the slxab32.dll file in the Windows\SYSTEM32 folder?
A: The slxab32.dll stands for “SalesLogix Address Book”. It contains the functionality for
selecting Contacts from SalesLogix for the e-mail, automatically recognizing contacts in the e-
mail, and“Flagging” e-mail from SalesLogix contacts. It can be turned on and off in the Add-in
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Manager as well under the name “SalesLogix Outlook Add-in”. There are a few SalesLogix
Address Book options that can be configured in the Outlook “Services” section.
Q: Will Outlook integration work with the new anti-virus security being used in recent
versions of Outlook?
A: Yes. No special rights are required and the Outlook security is not compromised. Outlook
Integration is programmed at the Extended MAPI level with compiled executables, not scripts
using the Outlook Object Model which invokes the Outlook virus warning message.

Q: Will any of the Outlook specific features (like Send SLX button) work for non-SalesLogix
users?

A: No. You must be a SalesLogix user.

Q: Will the Outlook Integration work with Outlook Web Access (OWA)?
A: No. Outlook Integration depends on the full Outlook client. OWA is a thin client that lacks the
logic to interpret the commands being used.  SalesLogix Exchange Link does not require
Outlook so Outlook Web Access will show all synchronized Task, Calendar, and Contact
information from SalesLogix.

Q: Will the SalesLogix Address Book for Outlook allow me to select groups of Contacts?
A: Yes.  You will also be able to multi-select from the Contact, Account, or Opportunity list views
in SalesLogix, choose the Write > E-mail function, and have all of the relevant e-mail addresses
populated into the BCC field (a great method for sending quick, “non-personal” messages to
customers, prospects, or partners – like a quick “Happy Holiday’s” e-mail).

Q: Can I e-mail SalesLogix Library attachments?
A: Yes. In the Library, select the attachment and use the Write > E- mail function. The e-mail will
include the current contact and attach the Library file. In addition, if you create the e-mail from
Outlook, and chose the new “SalesLogix Library…” option under the Insert menu, you can
select files directly from the Library, without opening SalesLogix.
Q: Can I save the attachments in an e-mail to SalesLogix Contacts?
A: Yes. When you use the new Send SLX feature to send and save History (or if you use the
SalesLogix icon button or drag and drop method) a simple Yes or No prompt will ask if you want
to save the attachment(s) inside of SalesLogix. (If you choose Yes, the attachment(s) will be
saved under the Attachments tab in SalesLogix.)

Q: What about saving messages from my Outlook Inbox?
A: Yes. You have the SalesLogix icon button in Outlook and drag and drop functionality
available. In addition, the “attachment” logic as mentioned above is included so you can record
an e-mail and attachment(s) to the contact in SalesLogix with one click.

Q: How does Outlook find the right Contact in SalesLogix?
A: Outlook Integration searches on the Contact e-mail address field, and then on the
combination of Lastname and Firstname. If an inappropriate e-mail address or a duplicate is
found, you will be prompted accordingly.

Q: What happens if I click the Send SLX button and the e-mail address is not found in
SalesLogix, will the e-mail still be sent?
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A: Yes, the e-mail will still be sent and you will be prompted with a “Contact not found”
message. You can then add the Contact in SalesLogix and drag the message from your Sent
Items folder in Outlook to the appropriate SalesLogix Contact.

Q: When I click the Send SLX button, how does it “know” which recipients to write
history records for in SalesLogix?
A: Outlook Integration will look at all “unique contacts” (in this case meaning not in the same
account record) and will write a history record for each unique account, regardless of the
recipient’s location in the e-mail message (TO, CC, or BCC).

Q: What if I have internal employees as contacts in SalesLogix, will the Outlook
Integration create a history record for these people too?
A: You may configure Domain Exclusion rules to ignore internal employees (or any domain that
you don’t want to record to history).
Q: Will I be able to use the SalesLogix Address Book for Outlook and e-mail documents
from the SalesLogix Library while Outlook is “off-line?”
A: Yes. All of the features connect to Outlook, regardless of being “connected” at the time. The
SalesLogix Address Book for Outlook is dependent on a connection to the SalesLogix database.
Once the e-mail is “sent”, it will remain in your “Outbox” until a connection is made with the
Exchange server.

Q: Does SalesLogix have to be open for the Send SLX or SalesLogix icon button in
Outlook to work?
A: No. If SalesLogix is closed, a temp file will be written to a temporary directory and will be
stored until SalesLogix is opened.
Q: Can any Outlook Integration views be customized?
A: No. The Outlook views are not customizable.

Q: How does a SalesLogix user schedule an activity and invite a non-SalesLogix member
who only uses Outlook?
A: The “Attendee Availability” tab will look and function the exact same way (in fact it has the
same name) as the “Attendee Availability” tab inside of an Outlook Appointment. It will display
the schedule information from Exchange directly into SalesLogix.  When you click OK to
complete scheduling the SalesLogix meeting, you will be prompted if you want to send out a
meeting request to the other Outlook users that you’ve added. If you click Yes, an Outlook
Meeting Request e-mail is sent automatically to those users with the meeting information. Those
users can then Accept or Decline your meeting request.
Q: How will a non-SalesLogix user schedule an activity for a SalesLogix user?
A: Since the SalesLogix user’s calendar will always be mirrored with Outlook, the non-
SalesLogix user will simply schedule for the SalesLogix user using Outlook.
Q: Is it assumed that all SalesLogix users are also Outlook/Exchange users?
A: Yes.

Q: If scheduling activities for SalesLogix users, either in SalesLogix or Outlook, opens
Attendee Availability information from Exchange, what does this mean for SalesLogix
Activity confirmations?
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A: SalesLogix Activity confirmations will be replaced by Outlook’s “Meeting Request” e-mails.
After a SalesLogix user creates a meeting and adds another SalesLogix user (using the new
“Attendee Availability” tab in SalesLogix) to the activity, they will be prompted to send an
Outlook meeting request e-mail to the invited attendees.

Q: What if SalesLogix is closed when I receive a Meeting Request in my Outlook Inbox. If
I choose to Accept that request, will that meeting still be added to my SalesLogix
Calendar?
A: Yes.

Q: Can I just use the Outlook Calendar from SalesLogix instead of the standard
SalesLogix Calendar?
A: Yes. In the Tools > Options > Calendar tab, each user will be able to change the Default
calendar from SalesLogix to Outlook. (Note that the Calendar will NOT be embedded like the
“Attendee Availability” tab, but SLX will open an instance of the Outlook Calendar when the
Calendar NavBar button is clicked.)

Q: What about “completing activities” since this concept does not exist in Outlook?
A: Correct, you cannot “complete” activities in Outlook like you can in SalesLogix and as it turns
out, all Outlook users handle this in several ways:

 The Outlook user might delete the activity

 The Outlook user might leave the activity on the calendar

 The Outlook user might mark a field, like Category, as “Completed.”

So, rather than guess what your intentions are in Outlook when deleting an appointment and
mistakenly deleting the corresponding activity in SalesLogix, the Priority field in the SalesLogix
activity will be marked as “ISYNC DEL”. You can then sort the Priority column on the SalesLogix
Activity view, multi-select all the activities, and delete them.

Since one of the most important and valuable features in SalesLogix is keeping a company-wide
history of all activity within an account, it is recommended that users continue to complete
activities within SalesLogix so that you and the rest of your organization can maintain that
historical view into the account. If you complete an activity in SalesLogix, the corresponding
appointment is kept in the Outlook Calendar and if an alarm exists, the alarm is removed. If you
want Outlook to automatically remove those activities, you can use the Auto-Archive feature
inside Outlook to archive activities older than X days.

Q: If a Contact is deleted in Outlook, is it deleted in SalesLogix?
A: With Intellisync, the Contact will just be removed from your Ad Hoc group but it will still be a
Contact in the SalesLogix database. With Exchange Link, this is the default behavior but can be
configured to delete the Contact in SalesLogix (not recommended).

Q: When a new contact moves from Outlook into SalesLogix, does SalesLogix check for
duplicates?

A: Yes, With Exchange Link dupe checking may be configured.

Because of limitations in Intellisync, dupe checking is limited to the Contacts that are in the
SalesLogix ad hoc group you assigned to sync with Outlook. Therefore, it is recommended
before you add a contact to the sync stream (as previously discussed), you check the
SalesLogix database for an existing occurrence of the record. If you do find a match, add that
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contact record to the group you are synchronizing Outlook with, then run Intellisync and let it
create the match so that no duplicate will be entered into SalesLogix.
Q: Are there any limitations to SalesLogix Exchange Link?
A: At this time, there are a few limitations compared with Intellisync.  SalesLogix Exchange Link
requires:

 Access to the Exchange Server with Administrative access

 A two-way link.  Exchange Link cannot be configured for a one-way link.  For example,
no way to specify that contacts and calendars are copied from SalesLogix but changes
in Outlook/Exchange do not change in SalesLogix

 SalesLogix Events are not linked.  Events are not widely used and are distinct from
Activities and other calendar items.  This should not be an issue for most customers.

Q: Does SalesLogix Exchange Link require SalesLogix v6.2?
A: Yes, only v6.2 or higher is currently supported.  SalesLogix v6.0, v6.1, and v5.2 are not
supported and are not compatible.

Q: What software and configuration is required on the Exchange Server for SalesLogix
Exchange Link?
A: No software or reconfiguration is required on the Exchange Server.  Exchange Server does
not need to be restarted to connect the link.  All software is loaded on the SalesLogix Server (or
additional server).  The link does require administrative access to Exchange Server to update
information.

Q: Must I have Administrative rights to Exchange Server for SalesLogix Exchange Link?
A: Yes, SalesLogix Exchange Link adds, updates, and deletes information from Exchange
Server on behalf of any and all users therefore requiring Administrative rights.  See the
Exchange Link Implementation Guide for details on setup.

Q: Can I sync to different SalesLogix databases?
A:  Yes, with Exchange Link because it is server-side and sync depends on the user.

No, with Intellisync. Intellisync does not support synchronization between multiple SalesLogix
databases and Outlook (essentially “triangular synchronization”).  If you are a remote user who
needs to switch between connecting to the SalesLogix Main Office database and your personal
SalesLogix remote database while traveling, you must set Intellisync to “Export”, otherwise data
corruption and unwanted duplicates may occur.  (If both Contacts and Calendar items are being
exported, it is recommended that you use the Outlook Calendar at all times so that meetings
scheduled in SalesLogix and Outlook Meeting Requests are viewed in one calendar.)

SalesLogix is a registered trademark of Best Software. SalesLogix Client, SalesLogix Support Client, SalesLogix Web Client, and
SalesLogix for Web Phones are trademarks of Best Software.

Internet Explorer, Microsoft Office, Microsoft Outlook, Microsoft Word, Microsoft Excel, Microsoft Exchange, Microsoft Internet
Information Server, SQL Server, and Windows are trademarks and/or registered trademarks of Microsoft Corporation.

Oracle is a registered trademark of Oracle Corporation.

Other product names mentioned in this document may be a trademark or registered trademarks of their respective companies and
are hereby acknowledged.


